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INTRODUCTION
CASELOAD MANAGEMENT MADE SIMPLE
At present many correctional agencies and institutions are overwhelmed with over-crowding and
excessive probation caseloads. With this in mind, Caseload Explorer software was designed to assist
corrections personnel in managing their daily workload. It is a complete probation management tool
enabling officers to access an abundant amount of information in a web-based architecture. The software
enables you to capture a broad range of information by its intuitive navigation flow and ease of use. The
data input screens have been designed to facilitate the data capture process and many provide a final
review screen to encourage verification of entered values.
After becoming familiar with Caseload Explorer’s Main Window, you will become immersed in the
concept of the Property Sheet. After mastering this concept, you will truly appreciate its ease and
simplicity. All major grouping of data elements belong to a property sheet. For example, once you select
a person’s name, it will open up the selected client’s Property Sheet. This is an organized file containing
tabs of information, with commonly accessed information appearing on your screen and other categories
just a click away! Let’s get started so Caseload Explorer can assist you in managing your daily activities.
TECHNOLOGY OVERVIEW
Caseload Explorer runs within a web browser and contains only web pages. Caseload Explorer is
implemented within your organization’s private wide area network. It is a web browser-based

application that takes advantage of all the features offered in Microsoft’s Internet Explorer version 8 or
higher
This web-based application utilizes the HTTP nodes on your organization’s private wide area network. It
is accessible only by your agency’s employees. An intranet’s Web site looks and acts just like any other
Web site. However, another system called a “firewall” prevents unauthorized access to or from your
private network.
Just like the Internet, the purpose of an intranet is to share information. It provides an ideal environment
for continuously updated internal information. Furthermore, this powerful, inexpensive communications
alternative provides information anywhere at any time.
Since Caseload Explorer is a web-based product, other world-wide-web products can be seamlessly
interfaced into Caseload Explorer. For example, Caseload Explorer contains a link to a mapping utility.
This way, officers may instantly retrieve a map designating the client’s primary on.
HOW TO READ THIS GUIDE
This guide is intended to demonstrate the general concepts of how the software is designed and explain
the purpose of Caseload Explorer’s components. Since each agency employs a different data
management strategy, Caseload Explorer’s architecture has been designed to be flexible so it may
accommodate each agency’s needs.
This guide will not concentrate on specific work flows; instead it will focus on how to manipulate the
various entities of data to assist you in your daily activities. The guide begins with pertinent information
such as how to logon then describes the Main Window and its components. Next, the concept of a
Property Sheets is introduced. The screens displayed in this guide are samples to depict the techniques.
Each installation captures different data elements, although the concept remains the same!

CHAPTER 1: GETTING STARTED NAVIGATING CX
CX OFFICER HOMEPAGE
After successfully logging on, Caseload Explorer’s Officer Homepage appears. From the homepage, you
may view your calendar, check your messages, access your caseloads and clients, view client services,
and manage client finances.
The homepage contains a menu bar, a main window, and several panels:

The default homepage configuration displays the supervision tree-node pinned to the left of the main
window. Tabs for the Recent and Messages panels are visible on the right; you can make the panels
appear by hovering over their tabs. Below the menu bar are the main window view tabs. Each of these
homepage components are described in the following sections.

MENU, NAVIGATION AND QUICK-SEARCH BAR

At the top of the homepage you can find the drop-down menus, navigation icons and quick-search
bar.

Like most applications, CX 5.2 uses drop-down menus to access different features and perform many of
its functions. The menu options and their functions will expanded upon in subsequent chapters within
this guide.
To the right of the drop-down menus, you will find three navigation icons:
Accounting Module
Service Management Module
Officer Homepage
Clicking on these icons allows you to navigate between the Officer Homepage, which contains
information about your caseload, and the Service Management Module and Accounting Module, both
of which are described in a separate user guide.
On the far right you will find two quick-search fields (see page 19). From these fields, you may perform
quick-searches for cases and clients, the results of which will appear in a new window.

MAIN WINDOW TABS

The CX homepage contains three view tabs that allow an officer to access his or her most important
information directly from the main window.

The Calendar tab enables officers to view and select scheduled offender contact events. By clicking on
the corresponding calendar view buttons, you may choose to view you schedule by day, work (5-day)
week, (7day) week, month, or as an agenda list.

The My Clients tab allows officers to view all clients within their caseload.

The List View tab displays the details corresponding to a selection made from the Supervision tree-node.
This tab will be different for each tree-node selection. The Supervision tree-node is discussed in the
following section.
SUPERVISION TREE NODE
The supervision tree-node can be found in the Supervision panel, by default pinned to the left side of the
homepage. Clicking on the book icon will expand that tree-node item and display its contents below.
Clicking on tree-node items with a page icon will display their content in the main window List View
tab.
Within the supervision tree-node, you can
navigate to all information pertinent to your
caseload and your schedule.

Additionally, many features described later in
this guide are accessible from within your
supervision tree-node.
Tree-nodes may differ between counties, so
please contact your county’s CX 5.2 system
administrator for details about your tree-node
organization.

QUICK ACCESS PANELS

At the right of Caseload Explorer’s main
are tabs which enables you to
quick-access panels.
hidden until

window
access two different
Both of these panels are
scrolled over with your mouse.

Recent quick-access panel: Contains recently access clients.

Messages quick-access panel: Contains messages, news, and alerts.

Either quick access panel can be pinned open,
Supervision panel, by clicking on
the corner of the panel.

like the
the pin in

INTRODUCTION TO PROPERTY SHEETS
Caseload Explorer employs property sheets to manage all information on a given client. Property sheets
are also used to store information about organizations, like courts or service providers, and associates
(non-client persons), like judges, organization-contacts, victims or relatives of a client. Officers and
caseloads also have a property sheets.
If you click on the name of a client, organization, associate or caseload from with CX, a property sheet
for that object will appear in a new window. The information in a property sheet is logically grouped into
pages, each with different types of data records.
Below are examples of property sheets you will encounter within CX 5.2. Each type of property sheet is
detailed in its own Chapter, later in this guide.

Client Property Sheet ( p29)

Associate Property Sheet (p101)

Organization Property Sheet

(p94)

Caseload Property Sheet (p109)

CHAPTER 2: OFFICER PROPERTIES AND FEATURES
OFFICER PROPERTY SHEET
Probation staff members have an officer property sheet which details their basic information and
caseload assignments.

➔ Access your property sheet by clicking on your name in the Supervision tree-node.

Your Property Sheet

➔ Access another officer’s property sheet by
clicking on their name to open up a new window
(See p27 for officer search).

Another Officer’s Property Sheet
BASIC INFORMATION
The Basic Information section displays an officer’s contact information, position, site, alerts statuses,
availability, and back-up officer. Officers may edit these attributes from their account, including their
login information and password.
Editing Attributes and Officer Login Information

➔ To edit an attribute associated with your account, simply click on the attribute. A new window
will open allowing you to edit the attribute and then save the changes.

When editing most attributes you also are presented with history of any previously entered but currently
inactive data. Click on any previously active data to automatically copy-paste that data into the Current
Value field.

ALERTS
When you are assigned a new client or case, or any of your client’s properties, case events, or program
statuses are updated by another officer, you will be sent an alert. You may also request alerts for
overlapping appointments.

➔ Select which types of alerts you wish to receive by changing their state in the Alert Requests
section. Click on the blue triangle next to any alert state, then click Add/Edit to open up an Alert
Requests editor window.

➔ View your alerts by clicking on the Delivered Alerts section of the Supervision tree-node.

Alerts may also be view from the Messages quick-access panel.
MESSAGES SECTION
The Messages feature allows the exchange of text-based messages among Probation staff. This feature
also allows officers to exchange messages with clients via Kiosks.
Viewing and Replying to Messages

➔ To access your messages, expand the Messages quick-view panel. By default, only message
sent within the last 30-days will appear in the quick-view.
Messages regarding a particular client will contain the client’s name attached to the subject line:
RE: {Client Name}.

➔ To view message details in a larger window, click on the blue triangle and select
View Message.

➔ To reply to a message, click on the Reply button.
A new create-message window will appear with
pre-filled recipients and a copy of the message to
which you are replying. See the next section for
details about the create-message window.

Creating and Sending Message

➔ Create a new message by clicking on the blue triangle next to Messages in the Messages
quick-view and selecting New Message.

Select officer recipients from the Officer drop-down menu. Click on ‘Add another recipient…’ to add
an additional officer. The drop-down menu will reset allowing you to select an additional officer.

Select delivery date and time from the M
 essage Options section of the dialog.
Select a client who the message is regarding by clicking on ‘Select Person…’ to open up a search dialog.

To send the message, click on the Save
button.
Note: T
 he message will be delivered on or
after the date and time selected.

➔ Send a message to a client, simply select the Client-via Kiosk option in the Recipients section.

Add client recipients using a search dialog by
clicking on ‘Select Person…’

View Message History

➔ View a complete history of messages you have sent or received by clicking on the messages
Supervision tree-node option.

You can view the content, send date, sender, recipient, date received, and subject of all messages in
message history.

➔ Filter the messages by Sender, Recipient, or client Kiosk.

OFFICER LOCATION/AVAILABILITY

➔ View the current Location and Availability of Probation Officers by clicking on Officer
Location under the My County tree-node item.

➔ Update your availability and location by changing the Availability and Site attribute on the
Basic Information section of your property sheet.

OFFICER CLIENTS AND CASELOADS
From the Supervision tree-node, you can view a complete list of your clients, add clients to a digital
queue for an office visit, access any of your client’s active service or financial obligations, or view any
pending transfers or adjournments related to one of your clients.
You may also view a list of your active caseloads, in addition to any case-related responsibilities still
pending completion. The Supervision tree-node contains
All Clients

➔ View a complete list of your clients by navigating to All Clients under the Officer Supervision
tree-node item.

Open the client’s property sheet by clicking on their name.

➔ Place a client in the Waiting Room by clicking on the
blue triangle next to their name and selecting Waiting
Room. This feature is discussed in detail later in this
section.
Activities Due

➔ View a list of any case-related activities or work items for which you are responsible by
selecting Activities Due under the Officer Supervision tree-node item.

Click on a client’s name, a case number, or an officer’s name to open up the corresponding
property sheet. Activities listed in red are overdue.

➔ Filter by due-date or activity using the filters at the top of the list. You may filter for multiple
activities.

Client’s Active Obligations, Pending Transfers, and Pending Adjournments

➔ View all active community service orders
for any of your clients (see chapter 4,
services section).

➔ View all financial obligations for any of
your clients. These obligations include court

fees, service fees, supervision costs, and
restitution.

➔ View all pending transfers for any of your
clients by selecting Pending Transfers from
the Officer Supervision tree-node.

➔ View all pending adjournments for any of

your
clients
by selecting Pending
Adjournments from the Officer Supervision
tree-node.

Waiting Room
You can use the Waiting Room feature to place clients into a digital queue upon their arrival for an office
visit. The waiting room will display offenders by time-of-arrival. Additionally, the date of the client’s
last office visit as well as percent of successful kept appointments will be shown.

➔ Add a client to the waiting room
by navigating to All Clients under
the Officer Supervision tree-node,
clicking on the blue triangle next
to the desired client’s name, and
selecting Waiting Room.
Adding a client to the waiting room creates a
pending contact event.

➔ View queued offenders in the Waiting Room by clicking on Waiting Room under the Officer
Supervision tree-node item.

Offenders waiting longer that 30 min will appear in red.

➔ Remove an offender from the waiting list by completing the pending contact. Open the

pending contact event by clicking on the blue triangle next to the client name and selecting
Complete Contact Event.

Note: Contact events are explained in the Managing Clients section of this guide.

CHAPTER 3: FINDING PERSONS OR ORGANIZATIONS
Several search tools are available in CX 5.2, including the quick-search bar and Find menu options. This
section details each tool and how they can be used.
QUICK-SEARCH BAR
The quick search fields, located in the right side of the menu bar, allow you to perform searches for
clients or cases.

➔ To search for a client, enter the client’s last name in the field labelled Search and press the

green arrow button. If you enter a client’s PIN and press the green arrow button, that client’s
property sheet will be opened automatically.

If you don’t know a client’s full last name, you can type a few letters and CX will try and match it with a
name. However, if searching for a client by PIN, you must enter a complete number.

Click on a client’s name to
open their property sheet.

➔ To search for a case, enter the case number into the field labeled Case and press the green arrow
button. If you can’t remember the entire case number, use an asterisk or question mark as a
wildcard.

➔ Filter for case type by selecting from the drop-down menu, or filter for active cases by
selecting a status.

➔ To open and view the case, click on the case hyperlink. It will open in the cases tab of the
relevant client’s property sheet. The cases tab is described in chapter four.

➔ To open the property sheet of the officer to whom the case belongs, click on the officer’s
name.
FIND PERSON
To perform an advanced search for any client or associate, you may use the Find Person search function.
This function will allow you to search for a person using parameters other than their name or PIN.

➔ Open the Find Person dialogue by clicking
on the Find menu and selecting Person.

The Find Person dialogue will open in a new window containing three search tabs.
Parameters entered in any of the tabs will be included in the search simultaneously.

When searching from any of the tabs, choose the amount of results you wish you view at any time
using the fields below the Search, Clear, and Cancel buttons.

After performing a search, enter new parameters in another tab and search the results currently
displayed by clicking on the update button
Common Search

➔ Search for clients, associates, or both, from the common search tab.
Both the first or last name of a client can be used as a search parameter, in addition to the PIN. You may
filter results by status or aliases.

➔ Search for a name you know but can’t spell by selecting the check box next to Do Soundex.
Alternatively, use wildcards ( * or ? ) to a match several letters to a name.

Gender & DOB Search

➔ Search for or filter clients by gender or age range from the Gender & DOB tab.
You may manually enter a date range, or perform a search within a given two-tailed range from any
given date.

Attribute Search

➔ Search for and/or filter clients by any of their attributes using the attributes search.
Select an Attribute Group.

Select an Attribute

Select an attribute value and comparison type

In order to search for clients that used to, but do not now have that attribute, select the Checkbox
next to History.

Add the attribute. It will disappear from the selection menu and appear below, saved.

Repeat the steps to add attributes as many times as desired.
Search for clients with the selected attribute(s) by clicking on search.

To open the property sheet of the desired person, click on their name.

FIND PHONE NUMBER

➔ Search for clients or associates
by their phone-number by selecting the Phone menu option from
the Find me
Specify mobile, office, etc., by selecting from the Type
drop-down menu.

To search for old phone numbers that
may no longer be active, deselect the
checkbox next to Active Only.

FIND ADDRESS

➔ Search for clients by their
address by selecting the Address menu option from the Find
menu.
Enter one or more parameter into the address fields.

To search for old address that
may no longer be active,
deselect the checkbox next to
Active Addresses Only.

FIND OFFICER

➔ Search for officers by selecting
the Officer menu option from the Find menu.

You may select a region, site or
position from the drop-down
menus. These drop-down menus
will differ by county.

FIND ORGANIZATION

➔ Search for Organizations
by selecting the Organization menu option from the Find
menu. Organizations include courts, service providers, and
legal agencies, as well as other entities like client employers or
gangs. Organizations are described in chapter five.

Search for a particular type
of organization by selecting
that type from the drop down
menu.

FIND CASE

➔ Search for cases by
selecting the Case menu option from Find menu.

Filter by case type or status by
selecting from the drop-down
menus.

FIND CASELOAD

➔ Search for caseloads
by selecting the Caseload menu option from the Find menu.

Clicking on a caseload returned by this search will open the caseload property sheet (see p109 for
Caseload details).

CHAPTER 4: MANAGING CLIENTS
CLIENT PROPERTY SHEET
The client property sheet contains all the information on a given client. From the client property sheet,
you can view and update client basic information, such as physical attributes, residence, or family
members, and also manage client obligations, such as court events, community service, or financial
retribution. The client property sheet is organized into a set of tabs, each devoted to a assisting with the
management of a particular type of client data.
OVERVIEW

➔ View a client’s mugshot and a summary of their information from the Overview tab.
On the overview page you will find the client’s mug shot and contact information
along with a summary of supervision information, service requirements, financial
obligations, case information, and physical attributes.

➔ Edit an attribute on the overview page by clicking
on it.
The Edit Attribute dialog will appear. Enter a new
value and click Save.
Copy-paste an attribute value from the History
section into the Current value field simply by
clicking on it.

➔ Toggle

the
upper
right
information panel to show
different overview information
by clicking on the blue triangle in
the upper right corner.

➔ Set

a warning to appear
whenever the client’s property
sheet is viewed by clicking on the
warning attribute.

CASES TAB
The Case tab is used to collect history for cases from intake and investigation through supervision, and to
provide information regarding the client’s court proceedings.

➔ View a client’s cases list and the case attribute panel from the Cases tab.

The cases list provides a list of the client’s case folders and any case services within that case folder.
Case services are always linked to a parent case folder.
The case attribute panel contains attribute category tabs displaying information corresponding to
whichever case or case service is selected.

Creating a Parent Case Folder

➔ To create a new case folder, click on the blue triangle at the top of a client’s the
Cases List. Then select New

→ Case Folder.

Select the case folder type from
the drop down menu.

Assign the case folder to a
caseload by selecting from
existing
caseloads
in
the
drop-down menu.
Choose the case’s role from the
drop-down menu.

Click next.
Depending on the case folder type selected, you will be directed to the Create Criminal Case Folder
dialog, or the Create Family Case Folder dialog.

Select the case folder attributes by filling in all relevant information in the dialog.

Click Next.

Add a charge by clicking on the blue triangle and selecting New
Choose a charge type from the drop-down menu.

Select a statue in the drop down dialog. You may use wildcards ( * or ? ) to aid your search.

You may open an advanced
the statute drop-down field.

Select the charge count and
make a comment in the charge
details section.

Add the charge by clicking Save.

search field by clicking on the plus sign next to

If necessary, repeat the previous steps to add additional charges.

Click Next.
Review the case folder attributes.

Create the case folder by clicking on Finish.

The new folder will now be visible from the cases list.

Adding a Case
Officers can add new intake, investigation, supervision, and pre-trial cases to the related parent case
folder.

➔ Add a case to a case folder by clicking on the blue triangle and selecting New → Case.

Select a case type from the dropdown menu. The case number will be generated automatically. After
case type is selected, the available parent case folder(s) will appear below.

Select the
folder.

desired

Assign the case
officer’s caseload.

case

to

an

Select a case service role.
Click Next.
You will be directed to a case creation dialog specific to the case type selected.
Select case attributes. The attributes presented for selection will be different for each case type
(investigation, supervision, intake, etc.).

Click Next.
Review the case attributes.

Create the case by clicking on Finish.
View/Edit Case Information from Case/Case Folder Attribute Panel Tabs
Several categories of case information are available from the tabs below a selected case.

➔ View a case’s general attributes from the Details tab in the case attribute panel. Navigate between
Details attribute categories from the hyperlinks at the top of the tab.

➔ Edit a single case detail by clicking on its name.

➔ Edit all case details at once by clicking on the Edit All hyperlink at the bottom of the page.

➔ View charges associated with a case folder or case from the charges tab.

➔ Create a new charge or edit a previous one by clicking on the blue triangle next
to the charge. (See create parent case folder→ add charges dialog)

➔ View case events from the Events tab.

➔ Create a new event or edit/view and old event by clicking on the blue triangle
next to and event.

(See p55 for Events Section details)
Only client events related to the case will be displayed in this tab. All other client events are displayed in
the Events tab of the client property sheet.

➔ View Case Caseloads (Case Services) from the Case Caseloads tab.

➔ Edit or add case service assignments to a case or case folder by clicking on Manage Caseload
Assignments.
Add a new case service assignment by clicking on Add New Service…

or
Edit any Assignment details from the Manage Client Caseload dialog.

Click Save.

Select a caseload and role for the new caseload assignment. Click Save.
➔ View all non-client, non-P.O. persons associated with the case from the associates tab.

➔ Add a new associate, or edit an existing one, by clicking on the blue triangle next to the
associate.
(see p84 for Associates)

CONDITIONS

➔ View all active client conditions from the conditions tab.

The Conditions tab assists officers with entering and tracking conditions for a client related to a
given case. Conditions may differ by county.

➔ Add or edit client conditions by clicking on any blue triangle.

The conditions editor dialog will appear.
Select a case for which you wish to add or
edit conditions.

All conditions applicable to the case type will be displayed in the editor. Additionally, preset
condition groups are available, specific to the case type.

Select

conditions

individually

by

selecting the checkbox next to that
condition.

Enter the date at which the conditions
become effective into the first text box.
You may enter the completion date now, or
at a later time.
Alternatively, select all conditions at
once by selecting the checkbox next to the conditions group name. Enter the date in the box that says
Effective. That date will automatically be applied to all selected conditions.

Apply the conditions by clicking on Save.

➔ Create custom conditions by clicking on the blue triangle at the top of the conditions tab page
and selecting Add Custom.

Select a case to which the custom conditions will be
applied.

Enter custom text, or select and edit the text of an existing template.
Add the custom condition by entering the copy count, clicking Generate, and then selecting the
checkbox next to the generated condition.

Enter the effective date (completed date may be entered now or later) and click save
DOCUMENTS
From the documents tab, officers may create, edit or view a MS Word Form, or import documents from
their local computer. Additionally, documents may be directly scanned, and live images directly
captured, using a TWAIN source.
➔ View a list of forms and image files for a client from the Documents tab.

All documents have a particular type but may or may not be linked to a case.
Filter the
documents
list
by
type or by
case using
the
drop-down
menus at
the top of
the page.

Create a Document from a Word Form Template
(See p117 for Word Form Templates)

➔ Create a new
client document from a Word Form template by

clicking on any blue triangle and selecting the Word Form
menu option.
Select a template that you wish to populate with the
client’s data by selecting the checkbox next to the template
and clicking on the Launch Word button.

MS
Word will open the template and automatically populate the document with the client’s information.

You may edit the document if desired.
To save the document, save the word document normally. A save dialog will appear.

Choose desired save options by selecting the checkbox next to the applicable option, and then click on
Save.
Note: If Generate PDF is selected, a PDF will be generated in addition to the Word Document.
The document will now be available in the client Documents tab.

Scanning a Document or Image

➔ Scan a document or image into CX by clicking on the blue triangle in the top left
corner of the page and selecting either Twain Scan or Twain Photo.
The procedure for both scan
and photo is identical. The
only difference is the format
in which the file is saved.

If the Twain source is properly
configured, you will see a preview
of the scanned document. If you do
not see
a

preview, or an error occurs, please contact you system administrator.

Scan the document or image by clicking Acquire. Click Next.

Select the document type from the drop-down menu.

If applicable, select the case with
which the document is associated
from the second drop-down menu.
Enter the date and an annotation if
desired.

Click Next.
Review the scan/photo details.

Save the scan by clicking on Finish.
Capturing a Mugshot or Live Image
➔ Capture a mugshot by clicking on a blue triangle and selecting Capture Mugshot.

Initiate the image capture device by click on Start Camera. If you do not see an image, or an error
occurs, please contact you system administrator.

Capture an image by clicking Capture Mugshot. If you do not like the image, restart the image
capture by clicking on Start Camera.
Save the image by clicking Save Mugshot.
Edit mugshot details

Click
Next.
Review the details.

Save the mugshot by clicking Finish.
Viewing

Documents

or

Images

➔ View any document
simply by clicking on
its icon or Format
type.

Scanned
images
or
documents will open in the
CX document viewer.

Download the document or image
by clicking on Download Original
Document

Word form documents will open up in MS
Word.

Editing Document/Image Details

➔ Edit the details of a document or image by clicking on the blue triangle next to it and selecting
the Edit Details menu option.

From this page you may change the document type,
linked case, date, and annotation.

➔ Make a document read only by selecting the
checkbox next to read only.

Save your
changes by clicking on Save.

EVENTS
The events tab enables officers to record and track client events like contact events, assessments, court
actions related to their case, drug tests, re-arrests, transfers, or releases.

➔ View current and upcoming client events from the first page of the events tab.

➔ Filter the visible client events by date, case, or type,
using the filter option panel at the left of the events tab
page. You may select from preset date ranges, or enter
a custom range. Simply select or deselect the
checkboxes to filter by case or event type.
To apply the filter click on Apply Filter.

➔ Make your filter choice the default by selecting Save
Preferences.
View Event Details Summary

➔ View an event’s details summary by clicking on the plus sign by its date.

➔ To print a list of the currently visible events, click on any blue triangle and select the Print List
menu option.

Create an Event

➔ To create a new event, click on any blue triangle and select New Event. A list of event types
will be displayed. Select the desired event type from the
options.

menu

Some
events
are not
visible
in
the
quick
menu. If
you wish
to create
an event
unlisted
on the

quick-menu, like closing a

case, just click on New Event.
You will be able to select from
an unabridged events list in the
next dialogue.

The Create Event dialogue
will appear.

At the top will be the Event
Type panel.

From this panel you may select time and date options for the event. You may also change the event
type.
The event type panel will have slightly different options for each event type.
At the bottom is the event
details panel.

Enter all applicable event
information in the event
details section.

The details in this panel will be different for each event type.
To the right side of the screen may be another panel. Some event types do not require this panel. This
panel may require you to select offenders, cases or reports to which the event is regarding.

To save the event, click on Save.
Editing/Viewing an Event Details
To edit an event, click on the blue triangle next to the event and select the View/Edit option.
You will then be redirected to the
Create Event dialogue where you can
edit the details of the event and re-save
it.

SERVICE
The Service tab contains to pages:
The Community Service page displays all community service orders for a client.
The Other Services page displays and service program obligations for a client.

Community Service List View

➔ View a list of community service orders for the client in the upper half of the community
service page. Each service order is identified by the case to which it applies, start/end date, and
hours information.

➔ View the community service order attributes panel corresponding to the selected service
order in the lower half of the community service page.

Add Community Service

➔ Add community service by clicking on any blue triangle and selecting New.

Select the case to which the service applies, the start/end dates, and the required hours.

Click on Next.

Enter the applicable community service order details and attributes.

Complete the community service order by clicking Save.

View or Edit Community Service Order Attributes

➔ View the details of a selected community service order from the details tab of the attribute
panel. Navigate between attribute categories using the hyperlinks at the top of the panel

Edit an attribute simply by
clicking on it or edit all
attributes at once by
clicking Edit All.

Attribute history will be
displayed when editing an
attribute.
Add Completed Hours to a Community Service Order

➔ Add completed hours to a community service order by navigating to the Service Completed
tab, clicking on the blue arrow, and clicking New.

Enter all relevant information in the Add Community Service Completion dialogue.

Add the hours by clicking Save.

The added hours will now be reflected in the community service summary section.

Adjusting, Reopening, or Terminating Community Service Orders

➔ Adjust the hours of a community service order by navigating to the community service events
tab, clicking on the blue triangle, clicking New Event, and selecting Adjustment.

Adjust the service
hours as desired.

Save the adjustment
by clicking Save

The adjusted hours will now be reflected in the community service summary section.

➔ Terminate a community service order by navigating to the community service events tab,
clicking on the blue triangle, clicking New Event, and selecting Terminate.

Select the reason for termination and fill out all other relevant dialog fields.

Complete the service termination by clicking Save.

➔ Reopen a community service order by navigating to the community service events tab, clicking
on the blue triangle, clicking New Event, and selecting Reopen.

Fill out relevant dialogue fields and
click on Save.

A community service order can also be edited, deleted, terminated, or adjusted by clicking on the blue
triangle next to the desired community service order and selecting the applicable menu option.

Other Services / Programs List View

➔ Navigate to a list of programs to which the client has been assigned by clicking on the other
services menu option. Each service order is identified by its type and service.

View the service order attribute

panel in the lower half of the Other Services page.

➔ Filter

services
by
selecting from the type
filter at the top right of
the page.

Add a New Service

➔ Add a new service by clicking the blue triangle at the top of the Other Services page and
clicking New Service.

Select the service type.
The service provider and service drop-down
menus are dynamically populated by your
type and organization selection.

Select the Service Provider.

Select the service.

Fill out the relevant service details. These details will differ between service types.

Create the service by clicking on Save.
View Service Provider Information for a Selected Service Order

➔ Navigate to the services list with the selected service’s summary view by clicking on the
Services tab and selecting the Others Services menu option.

View or Edit Service Order Attributes

➔ View the service and service referral details in the details tab.

➔ Navigate between Details attributes categories using the hyperlinks below.

➔ Edit attributes by clicking on them in the attribute panel details tab, or by clicking on the blue
triangle next to the service on the service list and selecting Edit.

Create a Service Referral

➔ Create a service referral by clicking on any blue triangle on the other programs list and
selecting the New Service Referral menu option.

Choose the program to which you wish to refer the client by selecting the applicable service’s
checkbox.

Fill out the referral date, primary referral attributes, and secondary referral attributes. The
secondary referral attributes will differ between program types selected for referral.

Create the service referral by clicking on Save.
Mark and Program Attendance

➔ Record a client’s program attendance by navigating to the Attendance tab on the Other
Services page, clicking on any blue triangle, and selecting Mark Attendance.

Enter the attendance information into
the Attendance Editor.

Click Save.

Make a Program Note

➔ Make a progress note or a general note by navigating to the Events tab on the other services
tab, clicking on any blue triangle, selecting New Event, and the selecting the applicable note
menu option.

Enter the note into the comment field of the Create Event dialogue, and click Save.

Terminate a Service

➔ Terminate a Service by clicking on the blue triangle next to a service and selecting Terminate
Service.

Alternatively, terminate a service by navigating to the other services events tab, clicking on any blue
triangle, and selecting the appropriate termination option.

Select the termination type, fill out the appropriate dialogue fields, and click save

SUPERVISION
Administrative Supervision Page
A client’s administrative supervision status can be managed from the supervision tab.

➔ Navigate to the administrative supervision page by clicking on the Supervision tab and
selecting the Administrative Supervision menu option.

➔ Use the Active/Inactive filter to view inactive supervision periods.

Create an Administrative Supervision Period

➔ Create an administrative supervision period by clicking on the
plus sign in the top right of the administrative supervision page.
The Manage Administrative Supervision dialogue window will appear.

Select the start and end dates from the calendar menus.

Select the reason(s) for administrative supervision by selecting the applicable checkbox.
click on Okay.
The supervision period will now appear on the Administrative Supervision page.

End or Edit an Administrative Supervision Period

➔ End or edit an administrative supervision by simply clicking on it.

Then

Enter todays date to end the supervision, or enter any other date to edit. Click Okay.

Delete an Administrative Supervision Period

➔ Delete

an
administrative
supervision period by clicking on

the delete hyperlink at the end of its row.
It will be removed permanently and will not be
visible when the inactive filter is used.

View Graduated Responses Page

➔ Navigate to the graduated responses page by clicking on the Supervision tab and selecting the
Graduated Responses menu option.

➔ Use the Active/Inactive filter to see inactive responses.

Add a Graduated Response
In order to add a graduated response, the
administrative supervision period.

client must have an active or inactive

➔ To add a graduated response, click
the plus sign in the top right corner of
the graduated responses page.

The Manage Graduated Response dialogue
window will appear.
Select a category from the drop-down menu. The type drop-down menu will be dynamically generated
depending the response category.

Select response type and applicable case.

Click Okay.

End or Edit a Graduated Response Period

➔ End or edit a graduated response period by clicking on it.

Enter todays date to end the response period, or enter any other date to edit. Click Okay.

Delete a Graduated Response Period

➔ Delete a graduated response period
by clicking on the delete hyperlink at
the end of its row.
It will be removed permanently and will not
be visible when the inactive filter is used.

ACTION
Officers can use the action tab to perform several
client.

➔ View the action menu by clicking on the
Action tab.

Make Offender Confidential

➔ Make

an offender confidential by
selecting Confidential Offender from the
Action menu. The offender’s name will no longer

actions directly related to the

appear outside of their property sheet. Instead, a CONFIDENTIAL offender will be returned
when they are searched for.

New Message with Offender as Subject

➔ Generate a new message dialogue (see chapter 3) with the client automatically selected as the
message subject.

Seal Offender

➔ To seal a client’s record, select the Seal Offender option from the Action menu. This action will
seal the cases with which the client is associated, preventing changes to the case or client.
Additionally, the clients name will no longer appear outside of their property sheet. Instead it
will appear with a SEALED label, similar to a confidential offender.
Update Warning

➔ Update the warning that appears when a client’s property sheet is accessed by selecting the
Update Warning option from the Action menu (see the Overview section)

Waiting Room

➔ Put a client in your waiting room by selecting the Waiting Room option from the Action menu
(see chapter 3).
OTHER

➔ View a list of menu options clicking on the Other menu tab.
Accounting

➔ Open the accounting module to manage a client’s finances by
selecting the Accounting menu option.
Alerts

➔ View a list of all actions and attribute modifications performed
on a client by selecting the Alerts menu option.

Assessments

➔ Open the assessments module by selecting the Assessments menu option.
Associations

➔ View a client’s associations by clicking on the Associations option. Clients can be associated
with clients, organizations (see chapter 4) , or associates (see chapter 5).

Associations are used to indicate a person’s or an organization’s affiliation with a client’s case.
Association also may indicate a person’s or an organizations personal or professional affiliation with a
client.

➔ Add a new association by clicking on any blue triangle and selecting New.

Search for a person by name or PIN. If you wish to search for an organization, skip to page 12.

Click on Select to add the person as a client’s associate. The Associate setup wizard will appear.
Alternatively, if the desired associate person does not exist within the CX
database, click on Not Found to begin the Associate Setup wizard.
The Associate Setup wizard is identical for both updating associations and creating
new associations.
Select the case to which both the client and the associate are related. If they are not
related by a case, do not enter a case.

Select the role in which the associate is associated with the client. Associates can be associated with a

client in multiple ways. The role options will differ depending on whether or not a case is selected.

Roles with a case selected
Roles without a case selected
Fill out all other applicable fields in the of the Associate Setup dialogue.

Scroll to the bottom and
click on Save.
The new associate will be visible in the associations list.

→ To associate an organization with a client, select Organization in the Associate Setup dialog, enter
that organization’s name, and click Search.

If the organization does not yet exist in the CX database, read chapter 7 for instructions to create a new
organization.

Click on Select to
add
the

organization as a client’s associate.

Identify the role of the organization and select an associated case if applicable.
Select the relationship of the client to the organization. Click Save.
Attributes and Attribute Wizard

➔ View a list of all client attributes by selecting the Attribute option.

➔ Edit any attribute by clicking on it.
➔ Edit all attributes at once by selecting the Attribute Wizard from the Other menu.

Automated Reporting

➔ View the automated reporting page by selecting the Automated Reporting option.

Calendar

➔ Display the schedule of events for a given client using the calendar feature.

➔ Change the view by selecting Day, Work Week, Week, Month, or Agenda.
➔ Filter by status or event type using the filter in the top of the Calendar.

Reports

➔ View a list of report available to be generated for a client using the Reports option. Generate a
report by simply clicking on its name.

➔ Export

the
report by selecting a file format and clicking on Export.

Restitution

➔ View a client’s restitution orders. See Accounting Module section.
SMT: Scars, Marks and Tattoos

➔ Document a client’s scars, marks, or tattoos using the SMT dialogue.

To save a scar, mark, or tattoo, enter the location and description and then click Save.
To remove a scar, mark, or tattoo, set the location to < Select One > and then click Save.
To enter multiple scars, marks, or tattoos simultaneously, increase the number of input fields
by changing the number in the Rows field
Vehicles

➔ View and/or record the description and identification information for vehicles to which the
client has access.

➔ Add a new vehicle by clicking on any blue triangle on the
page and selecting New.

Fill out applicable information and click Save

Viewed By
➔ View a detailed record of every user who has accessed a client’s Property Sheet.

CHAPTER 5: MANAGING ORGANIZATIONS
ORGANIZATION PROPERTY SHEET
Organizations within CX have a property sheet which contains contact information, contact persons
within the organization, organization services, organization rates, and offenders using with the
organization’s services. An organization’s financial history can also be accessed through an organization
Accounting portal.
CX supports the following organization types:

●
●
●
●
●
●
●
●
●
●
●

Court
Employer
Gang
Law Enforcement Agency
Legal Representation / Law Firm
Payee
Probation Department
Prosecutor
School
Service Provider
Other

OVERVIEW

➔ View an organization’s information, details, and child organizations from the Overview tab.

➔ To edit any attributes, simply click on the
attribute

Attribute history will also be available.

Save changes by clicking on Save

DETAILS

➔ View an organization’s details by clicking on the Details tab.

➔ Edit any attribute by clicking on it or by clicking Edit All.

CONTACTS

➔ View contact persons associated with an organization by clicking on the Contacts tab.

➔ Add a contact by clicking on any blue triangle and
selecting New.

The Create Contact dialog will appear.
Search for the contact to make sure it does not already exist within CX.

If no match was found, create a new contact by clicking on Not Found.

Fill out all applicable fields in the Create Contact Dialog.

Save the new contact by clicking Save

OFFENDERS
➔ View any offenders using an organization’s service from the Offenders tab.

➔ Filter by caseload or by active/inactive using the drop-down menu at the top of the window.
RATES

➔ View an organization’s rates from the Rates tab.

➔ Update an organization’s rate by clicking on the adjacent blue triangle and selecting Set Rate.
Enter the rate value and rate type along with an other applicable information.

Click Save.
SERVICES

➔ View a list of an organization’s services from within the Services tab.

➔ Create a new service by clicking on a blue triangle and selecting New.
or

➔ Edit an existing service by clicking on the adjacent blue triangle and selecting Edit.

Enter a new or edit the existing service type, name, and description.

ACCOUNTING
See the Accounting Guide details on using the Accounting module.
View an organization’s finances using the Organization Accounting Portal.

Open the accounting page of any client listed by clicking on the client’s name.

CHAPTER
MANAGING ASSOCIATES

6:

ASSOCIATE PERSON PROPERTY SHEET
An associate property sheet exists for any non-client, non-officer person within the CX database.
Associates include organization contacts, like community service directors, counselors, or judges. Client
relatives, friends, gang affiliates, or employers will also have an associate property sheet.
Note: W
 hen an organization contact is created, an associate property sheet is also created for that contact.

OVERVIEW

➔ View an overview of an associates basic contact information from the Overview tab.

➔ Toggle the associate’s attribute panel from the blue triangle drop-down menu.
➔ Edit an associate’s attribute
by clicking on its name.

DOCUMENTS
Create, edit, or view an associate’s documents from the Documents tab. The Associate Documents tab
is identical to the Client Document tab.
See Chapter 4→ Other→
  Documents for details.
ASSOCIATES
Create, edit, or view an associate’s associations from the Associations tab. The Associate Associates
tab is identical to the Client Associates menu option.
See Chapter 4→Other→
  Associates for details.
ATTRIBUTES
Create, edit, or view an associate’s attributes from the Attributes tab. The Associate Attributes tab is
identical to the Client Attributes menu option.
See Chapter 4→Other→
  Attributes for details.
VEHICLES
Document or view vehicles to which an associate has access from the Vehicles tab. The Associate
Vehicles tab is identical to the Client Vehicles menu option.
See Chapter 4→Other→
  Vehicles for details.
OTHER
Restitution

➔ View restitution paid to an associate using the associate restitution accounting portal.

Convert to Offender

➔ Convert an associate to an offender by selecting this menu option. The Convert Associate to
Client

Select a client type

and caseload.

dialog will appear.

Click Convert

CHAPTER 7: CREATING NEW PERSONS OR ORGANIZATIONS
NEW CLIENTS

➔ To create a new client, select the Client option from the
New menu.

A search dialog will appear (See Chp. 2 for
search dialog details).

Perform a client search to ensure that the client does not already exist in the system.

If the person does not already exist, click on To New Client Wizard.

Complete the New Client Wizard. Fill in as many fields as possible before clicking on finish. The fields
marked required must be filled before finishing.

To create the new client, click Finish.

NEW ASSOCIATES
See Chapter 4→ Other→
  Associations to create an associate from a client association.
See Chapter 5 → Contacts to create an associate from an organization contact.

NEW ORGANIZATIONS

➔ To
create a new organization, select the Organization
option from the New menu.

A search dialog will appear (See Chp. 2 for search
dialog details).
Perform
an
organization
already exist within the system.

search to ensure that the organization does not

If the organization does not yet exist, click on Not Found to start the New Organization Editor
dialogue.

Select an organization type and enter and organization name. Enter any relevant details.

Click on Next.
Fill out relevant contact information.

To create the organization, click on Finish.

NEW OFFICERS

➔ To
create a new officer, click on New and select the
Officer menu option.

The create officer dialog will appear. Fill
out all required fields.

To create the officer, click on Save.

CHAPTER 8: CASELOADS – PROPERTIES & ASSIGNMENTS
CASELOAD PROPERTY SHEET
Each caseloads will have an individual property sheet. A caseload property sheet contains three
information panels: Basic Information, Officer Assignments, and Clients.

Basic information contains the name, type, location, and assignment overview of the caseload.
Officer Assignments contains the history of officer assignments for the caseload.
Clients contains a list of clients, cases, and case roles assigned to the caseload.
CREATE A CASELOAD

➔ To
create
a
caseload, select the Caseload option from the New menu.

The Create a Caseload dialogue will appear.
Enter all required information.

Create the caseload by clicking Save.
Reassign a Caseload

➔ To reassign a caseload to a different officer,
click on the Assigned To attribute in the Basic
Information section of the caseload’s property
sheet.

The Edit Caseload Assignment dialogue will appear.
Search for a new officer to which you wish to assign the caseload by entering his or her name into the
Officer drop-down search.

Click Save.

➔ To reassign a client to a different caseload, click on Reassign Clients.

Select a caseload from the drop-down box at the top of the Reassign Clients dialogue.

Select the checkboxes next to the clients that you wish to reassign.
Click Save.

Deleting a Caseload
➔ Caseload Explorer does not currently support the function to delete a caseload.
It is recommended that administrators reassign caseloads rather than delete them. Our software supports
the un-assigning, re-assigning, and renaming of caseloads to accommodate an agency’s assignment
standards.

Deactivating a Caseload
Deactivating a caseload will remove it
tree-nodes.

from dropdown boxes and the Supervision

➔ To set a caseload as inactive simply click on the
active attribute in the Basic Information panel of the
caseload’s property sheet.

Deselect the checkbox next to Active

Click Save.

CHAPTER 10:

REPORTS
The CX reports function allows you to generate reports
automatically populated with relevant data. These reports can
be viewed in and printed directly from your browser, but can be
exported to your local machine.

➔ Access the Reports
menu by clicking on Reports menu bar item. This menu
contains a list of report categories.

GENERATING A REPORT

➔ To generate a report, select the category of report you wish to generate from the reports menu.

A list of reports
available in that category will display in a new window. You may
navigate to another category using the drop down menu at the top.

To begin the report generation function, click on the report name.

Some reports will require the entry of parameters prior to generation. Enter desired report parameters
and click on the View Report button.

The report will then be generated.

EXPORTING, PRINTING, OR SAVING A REPORT

➔ Export a report by choosing an export format and clicking Export.

➔ Print a report by clicking on the printer button.

➔ Save a report by clicking on Save.

➔ View a saved report from the Saved Reports section. This section can be access by clicking on
any report on the reports list.

➔ View a saved report on a client or an associate from their documents section.

CHAPTER 9: WORD FORM TEMPLATES
ABOUT CASELOAD EXPLORER TEMPLATES
CX is integrated with Microsoft Word, enabling Officers to export CX data into MS Word templates
using embedded data fields.
When new documents are generated from CX, a Microsoft Word session is launched and a document
template is populated with the appropriate data from the CX database. After saving the document, it will
be accessible from the Documents tab of the relevant client property sheet.
All documents are saved in the CX database, not to a user’s local workstation. This allows for Caseload
Explorer to control access to documents using the internal permissions assigned to each permission
group.
Authorized staff will have the ability to create a new templates as well as generate, edit or view existing
documents.
CREATING A NEW TEMPLATE
➔ To create a new
template, select the Template option from the New menu.

A window will appear as CX
automatically launches MS Word. If it
does not launch, click on the Launch
Word button.

A data source dialog will appear when MS Word launches.
Select the data sources you wish to use for the template. These data sources will contain information
related to their title.

If the Event data source is selected, you
must also select the event type.

Note: Y
 ou can only specify a single event type to associate with each template, but multiple templates
can be associated to the same event type.
Display the selected data sources by clicking the ADD-INS tab on the Word
document. The CX custom toolbar will appear.

All data accessible within each data source will be selectable from drop the drop down menus.

Insert a data placeholder into a template by selecting it from
the drop down menus.

Data placeholders will be inserted into the document wherever the cursor is
They will appear in the format <<Data Source Name>>.

located.

Save the document normally. A Custom
Save Template dialog will then appear.

Fill out all applicable fields in the Save Template.

You may choose to share the template globally,
with a specific site, or just for your personal use.

Click on Save.
The template will now be available from the View Templates menu.

VIEW AND EDIT TEMPLATES

➔ View a list of available Word Form templates in the

Edit Templates window by selecting the Edit
Templates option from the View menu.

The Word Form templates list can be filtered by data
source, client type, or active/inactive.

➔ To edit a template, click the adjacent blue triangle
and select Edit. MS Word will open with the
template. Add new data sources and/or content and
save as if you were creating a new template.

DEACTIVATING AND PURGING A

TEMPLATE

➔ Deactivate a template
by clicking on its adjacent blue triangle and selecting
Remove. This function will mark the template as inactive.

➔ Re-activate an inactive template by deselecting the Active Only check-box in the corner of the
Template List. All inactive templates will become visible.

To
desired

activate, click on the blue triangle adjacent to the
template and select Enable.

➔ Purge a template
from the CX database permanently by clicking on the
blue triangle adjacent to the template that you wish to
purge and selecting Purge.
Note: This action is permanent and cannot be undone.

CHAPTER 11: SYSTEM ADMINISTRATION OPTIONS
The system administration menu is available to administrators who wish to make permanent changes to
CX data, or to configure system properties according to the needs of their county.
Permanent data changes include merging duplicated objects, deleting objects no longer needed, and
purging appropriate clients or associates from the database. Non-permanent changes available to system
admin include assigning previously unassigned caseloads and officers.
The System administration options menu also allows advanced system properties to be configured
according to the needs of a particular county. Additionally, permission groups can be created or updated
so that different user types have access to different CX features.

➔ Contact
Options.

AutoMon

for advanced training in System Administrative

Navigate to the System Administration menu by
selecting Options from the View menu.

UNASSIGNED
Manage Unassigned Caseloads

➔ Show a list of unassigned caseloads by clicking on Manage Unassigned Caseloads.

➔ Re-Assign a caseload by selecting Re-Assign next to the caseload. A Edit Caseload Assignment
dialogue will appear.
Enter an officer’s name under Current Assignment and select a role.

To re-assign the caseload, click on Save.
Manage Unassigned Officers

➔ Show a list of officers that are not assigned to a site by clicking on Manage Unassigned
Officers.

➔ Assign an officer to a site by selecting Re-Assign.
Select a site from the drop-down menu.

To assign the officer to that site, click on Save.

MERGING
If an associate, client, or organization is duplicated in the CX database, the merge function can be used to
remove the duplicated person or organization.
When merging, the person or organization to be merged will be deleted, but any information that is not
available in the main person or organization will be copied over during the process.
Merge Associates

➔ Merge two associates by selecting the Merge Associate menu option.

Click ‘Select Associate…’ to search for the main associate and the associate to merge. Find
Associate Dialog will appear.
Select the check box next to the applicable associates and
click Add.

Merge the associates by clicking the Merge button.
Merging Clients

➔ Merge two clients by selecting the Merge Client menu option.

Click Select Client… to search for the main client and the client to merge. The Find
Offender dialog will appear.
Select the check box next to the applicable clients and
click Add.

Merge the clients by clicking the Merge button.

Merging Organizations

➔ Merge two organizations by selecting the Merge Organization menu option.

Click Select Organization… to search for the main organization and the organization to
merge. The Find Organization dialog will appear.
Select the check box next to the applicable
organizations and click Add.

Merge the organizations by clicking the Merge
button.

DELETING
Delete an associate, a client, or an organization by using the delete function. CX will not delete
persons with financial obligations or organizations who are payees of financial obligations.
Note: Deletion is a permanent action that cannot be undone.
Delete Associates

➔ To delete associates select the Delete Associates hyperlink from the administrative options
menu.
Click on Add Person to Delete… to
select associates to delete.

Choose associates to delete by
selecting the adjacent check
boxes and clicking Add.

To delete the associates, click
on the Delete button.

Delete Clients

➔ To delete clients, select the Delete Clients hyperlink from the administrative options menu.

Click on Add Client to Delete… to
select clients to delete.

Choose clients to delete by selecting the
adjacent check boxes and clicking Add.

To delete the clients, click on
the Delete button.

Delete Organizations

➔ To delete organizations, select the Delete Organizations hyperlink from the administrative
options menu.
Click on Add Organization to Delete… to
select organizations to delete.

Choose clients to delete by selecting the
adjacent check boxes and clicking Add

To delete the organizations, click on the Delete button.

PURGING
Clients and associates can be purged from CX after meeting the necessary conditions displayed on each
purge page.
Purging Clients

➔ To view clients that can be purged, click on the Purge Adult Clients hyperlink on the
administrative options menu.

➔ To purge clients meeting the conditions, click on the Purge button.

A confirmation dialogue will appear
after a successful purge.

Purging Clients

➔ To view associates that can be purged, click on the Purge Associates hyperlink on the
administrative options menu.

➔ To purge associates meeting the conditions, click on the Purge button.

A confirmation dialogue will appear
after a successful purge.

EDITORS, PERMISSIONS, AND CACHING
CX editor functions allows advanced system configuration so that each county’s CX can be customized
to fit their needs.
Contact AutoMon for advanced system administration training.

➔ Configure system attributes like organization types, client attributes, case attributes, case folder
hierarchies, and tree-node options from the Manage Attribute Groups editor.

➔ Customize client conditions and condition groups from the Manage Conditions editor.
➔ Configure your CX calendar to reflect appropriate holidays from the Manage Holiday
Calendar editor.

➔ Specify relevant installation parameters using the Manage Installation parameters editor.
➔ Compose and assign logon messages from the Manage Logon Message editor.
➔ Customize service order types and properties from the Manage Service Type editor.
➔ Specify your county’s sites using the Manage Sites editor.
➔ Customize the statutes database using the Manage Statues editor.
➔ Search for and add valid addresses using the Manage Valid Addresses editor.
➔ Customize permission groups for different user types using the View/Update Permission
Groups dialog.

➔ Reset system data using the caching function.

CHAPTER 12: HELP SCREEN
OVERVIEW
Caseload Explorer includes functionality for a user to access a Help Screen while using the application.
Advanced system administrators can configure the help system according to their county’s needs.

Contact AutoMon for advanced help system training.
ACCESSING THE HELP SYSTEM

➔ To access the Caseload Explorer Help System:
Navigate to any screen and Select F1 from your keyboard. The help screen will
automatically appear.

Note: Please disable all pop-up blockers in order to use this feature.

